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1.INTRODUCTION

First Light Vision is the new graphical user interface (GUI) of First Light Imaging. It is meant to
configure and capture images from C-RED One, C-RED 2, C-RED 2 Extended Range (ER), C-RED 3,
OCAM? and C-BLUE One cameras.
Features included:

Configuration: FPS, exposure time, geometry, bias, flat..

Frame acquisition: start, stop, save buffer, load buffer..

Basic frame processing: clipping, mirroring, rotation..

Basic statistics: standard deviation, average, histogram, section..

Camera monitoring: status, temperatures, power consumption..

Camera maintenance

2.REQUIREMENTS

This application is available for Windows and Linux.
This application supports the following OS:
Windows 10 & 11
Linux ubuntu 16.04 LTS, 1804 LTS and 20.04 LTS
CentOS 7
It is also possible to work with Windows 7 but it is not officially supported and we will not provide any
support for this OS. Anyway, we recommend using Windows® 10 for USB acquisition.

It supports different acquisition interfaces, currently Camera Link®, USB3 and CXP.
For some frame grabbers, the drivers are not available for Linux so they cannot be used with the
Linux version of the application.

Acquisition device Windows 10 & 11 | Ubuntu * 20.04 Ubuntu ** 18.04 Ubuntu *** 16.04 CentOS 7

S LTS S
Matrox Radient ev- | X (C-RED 3) X (C-RED 3) X (C-RED 3) X (C-RED 3) X (C-RED 3)
K:/I:trox CXP X (C-BLUE 1) X (C-BLUE 1) X (C-BLUE 1) - -
EDT Vision Link 4 X (C-RED 3) X (C-RED 3) X (C-RED 3) X (C-RED 3) X (C-RED 3)
gilIFlow CL X (C-RED 3) X (C-RED 3) X (C-RED 3) X (C-RED 3) X (C-RED 3)
USB 3.0 X (C-RED 3) X (C-RED 3) X (C-RED 3) X (C-RED 3) X (C-RED 3)
Euresys CL X (C-RED 3) X (C-RED 3) & X (C-RED 3) & X (C-RED 3) X (C-RED 3)
Euresys CXP X (C-BLUE 1) X (C-BLUE 1) X (C-BLUE 1) - -
Pleora iPort CL-Ten | X (C-RED 3) ? ? ? ?
Sapera CL X (C-RED 3) - - - -

" Tested Kernel version Ubuntu 20.04 LTS 5.15.0-69

" Tested Kernel version Ubuntu 18.04 LTS 5.4.0-139

" Tested Kernel version Ubuntu 16.04.7 LTS 4.15.0-142

& : versions multicam-linux-x86_64-6.18.3 and above have some issues, the
delivered version multicam-linux-x86_64-6.18.2.4781 must be used

X available -:not available ?:not available during the test

The screen resolution must be at least 1920x1080.




3.O0VERVIEW

FirstLightVision Version:2.0.1_beta-3-g3c8d771 Model: CRED2 Hwuid: 01-00001643af%  Grabber: Matrox-Dev_0 - o x
File Tools View Plugins Help
Playback Buffer ‘ Image Processing | Image Statistics | Camera Control
> ] ( 0/6865 Camera Control & x
soms =] [El [Se:—\chm ][Guru j[ Collapse all ]
Acquisition File Left mouse click action Image Processing Register name Value B
7 MotherBoard (°€) ( 20.25 ]
¥ FrontEnd (°C) ( 43.25 )
r PowerBoard (°C) ( 43.25 )
Y sensor (°C) ( 19.42 )
Y7 peltier (°C) ( 31.03 )
¥¢ Heatsink (*C) ( 3217 )
Common
7 Preset [3 j
600.0132 H -
77 Framerate [ - :ll
1661.4690 -
T Exposure [ = :Il
Cropping
0 -
17 Offset X [I :l
0 B
17 OffsetY [I :l
640 -
T Width [ :II
=

Register name: MotherBoard
Display name: MotherBoard (°C)
Access mode: Read only

Description: MotherBoard temperature (°C).

o> I 7850

X: 639 ¥: 158 (index: 101759) ADU: 0 (Screen value: 0)
Buffer: 0/6865 - FPS: 0 - Sensor Temp: 19.35 - Status: operational

Fig. 1: First Light Vision Overview

The software is divided into two parts:
Left part is for the image display and acquisition control.

Right part is a tab for “Image Processing”, “Image Statistics" and “Camera Control” panels.

Each part will be described in this manual.




4.START-UP OF THE SOFTWARE

At first, the software will look for the grabbers connected to the computer:

Please select the grabbers to detect cameras:
[] epT-0

Matrox-Dev_0

[] sapera

[] usb#

[] MatroxCXP-Dev_0
Delay before auto detect: 7s

The user must select the grabbers connected to the camera to detect it.
If cameras are detected, the software will automatically choose one and adapt the GUI to the

camera.
A list of detected cameras is available in “File" -> “Settings” section “Camera” -> “Selection” to switch

easily between cameras.

Fig. 2: Grabber Detection

Camera
Detection [ Start ]
Selection | CRED2#01-00001643af9e#Matrox-Dev_0 A |

Fig. 3: List of detected cameras

Camera description in the list is;. CAMERATYPE#HWUID#GRABBERTYPE. In the example above, we
have a C-RED 2 with a hardware UID 01-000.01643af9e connected to a Matrox grabber.
If you choose a different camera (C-RED 3 or C-RED One) the GUI will automatically adapt itself.

If you start the software before the camera, you can restart a detection by clicking on “File" ->
‘Settings" section “Camera” -> “Detection”.

The software reads the available RAM in the computer and takes 20% of this value for the images
circular buffer.

At startup, the software will be displayed in basic mode: this mode is a lite version of the software,
eqgsier to use.
This document explains the advanced mode of the software, but basic mode has the same

behavior.




Ocam?2 Start State ? >

L™

In which state do you want to start the sorftware?
Attention: all these values will be wrote in the camera.

Camera type: |Ocam2K "I [ ] Simulator

Modes

@ Standard (240x240@2060Hz)
() Binning 2x2 {120x120@3620Hz)

Optionnal Modes (please check if you have subscribed them)

Cropping [(24[}]{12[}@363[}Hz] _I [] available

Binning 3x3 (80x80@4650Hz) [ available
Binning 4x4 (60x60@5900Hz) [ available

Gain: | 1 E': ] Flat
Bias offset: | 0 E'Z (] Bias

You will have to set the current configuration of the camera, because these parameters cannot be
read from it.

Fig. 4. OCAM? startup window




5.DETAILED DESCRIPTION

5.1.Console

The user can use the console to send commands to the camera. When a command is sent, the user
gets the response and the GUI is updated.
Below is an example with the FPS command provided:

Console Image Processing Image Statisti

[09:49:39]fli-cli> fps

Frames per second: 83.0002%6000
[09:51:53]fli-cli> set fps 400
Result:0K

[09:51:56]fli-cli> fps

Frames per second: 400.000000000
[09:B1:65B8]fli-cli>

Fig. 5: Console command example




5.2.Image Statistics

I Console | Image Processing | Image Statistics | Camera Control

Image Statistics 8| x
Togs (True ]
Frame Id (0 |
Frame number (2110386 |
AGC (0 |
Image marker (0 |
Nb frame count error (0 |
Cube analysis [True j
Depth (50 =)
Temporal standard deviation | 61.8685 |
Mean (10619.7 |
Spatial standard deviation (878.975 |
Mean (106221 |
Min value (6882 |
Max value (13558 |

Histogram Raw | Histogram Display |

500}
L.
w 400
C
X
e
[s)
]
o 200
E
3J
£
100
1 1 | I ] It
7000 8000 9000 10000 11000 12000
ADU Value

X: 7560.98 Y: 536.60

Fig. 6: Image Statistics module

The Image Statistics panel is made up of 4 parts which are refreshed every 200ms.




5.2.1. Tags

The Tags part displays information from the frame tags (first four pixels of the image), this feature
can be enabled/disabled with the checkbox.

For more information on the meaning of the displayed information, please refer to the user manual
of our camerai.

Tags [True ‘l
N sample [63 ]
N loop [8 ]
Readout number o0 ]
Frame number [114[} ]
Nb frame count error [U ]

Fig. 7: Tags C-RED One
The C-RED One tags are made up of five parts:

N sample, the number of the current image sample

N loop, the number of the current image loop

Readout number, the number of the image without reset

Frame number is the number of the frame since the camera has been started or the tag has
been enabled.

Nb frame count error is computed by the software. The software checks that the Frame
number is valid. If it is not, it increments the counter value. The frame number is valid if it is
equal to the frame number of the previous frame plus 1 (modulo the ring buffer size).




Tags

Frame Id

AGC

Image marker

[

Frame number [211[}386
[
[

Nb frame count error [

=
)

Fig.8: Tags C-RED 2

The C-RED 2 tags are made up of five parts:

Tags

Frame Id is the ID of the image in IMRO mode. Example, with a burst of size 6, each packet of 6
images will have an ID from 5 to O.
Frame number is the number of the frame since the camera has been started or the tag has
been enabled.
AGC is the conversion gain currently applied, O for High gain, 1 for medium gain and 2 for low
gain.

o Image Marker indicates if the image has been marked by the user thanks to an external

trigger.

Nb frame count error is computed by the software. The software checks that the Frame
number is valid. If it is not, it increments the counter value. The frame number is valid if it is
equal to the frame number of the previous frame plus 1 (modulo the ring buffer size).

[True 'l'
T (21005 ]
AGC [1 ]
Image marker [0 ]
Nb frame count error o ]

Fig.9: Tags C-RED 3

C-RED 3 tags are the same as C-RED 2 tags, except for “‘Frame Id" because there is no IMRO with
C-RED 3.




Tags [True
Frame number [341036
Nb frame count error [ﬂ'

Fig. 10 Tags OCAM?

OCAM? has only frame number and error count.

5.2.2. Cube analysis

'l

Cube analysis [True
Depth (s0
Temporal standard deviation [51-3535
Mean [1[}619 7

=
J
J

Fig. 11 : Cube analysis

The cube analysis part processes a cube of images with a default depth of 50 frames that can be
changed by the user. It displays the temporal standard deviation and the mean of the cube. The
processing is done with the GPU, if a not compatible GPU is detected, or if no GPU is detected, then
this part is not shown. The cube analysis can be enabled/disabled thanks to the checkbox, as it can

slow the GUI on slow computers.

5.2.3. Basics stats

Spatial standard deviation, spatial mean, min value and max value are always displayed and are

computed with the current frame displayed.




5.2.4. Histogram

Histogram Raw | Histogram Display

% 500

J

»
LR

Izg“f 300
L S 0
i

3 200
=
3

Z i

100}

| y 7 = | n | n | n |
5000 6000 7000 8000 9000
ADU Value

X: 5543.20Y: 548.83

Fig. 12 : Histogram

Two histograms are available, one for the 8b image that is the processed image displayed and one
for the 16b image that is the image directly received from the camera.

Each histogram displays the number of pixels for each value (0-255 for 8b and -32768-32767 for
16b) to have a repartition of the pixels in the image.




5.3.Camera Control

[ Console ‘ Image Processing | Image Statistics | Camera Control

Camera Control A x
(search... J[Guru ][ collapseal |
Register name Value
Temperatures
¢ MotherBoard (°C) [ 39,5 ]
¥ FrontEnd (°C) [ 36 ]
7 PowerBoard (°C) [ 32.5 |
7 Sensor (°C) [ 19.92 |
77 Peltier (°C) [ 25.49 |
77 Heatsink (°C) [ 26.1 |
Common
Presets
17 Current [2 j
17 Save [ Execute )

77 Framerate
pid Exposure
Cropping
17 Offset X
17 Offset Y

17 Width

83.0006 Hz E':

[ 12040.40320 ps :l

=]
O]

a1l

Register name: PresetNumber
Display name: Current

Access mode: Read write

Description: Change the preset of the camera.

Possible values: Preset 0:Preset 1:Preset 2:Preset 3:Preset 4:Preset 5:Preset 6:Preset 7:Preset 8:Preset 9

Fig. 13 : Camera Control panel

Camera control panel displays all the camera registers available, in order to read or write them. This

panel has:

A tool box (search, filter, expand/collapse all)

A tree view to interact with registers
A text view to display register details




Registers are arranged by status (Beginner, Expert or Guru) and each have a specific visibility. Status

can be chosen with the box next to the “Search” bar.
A fourth status “favorites” is available. It is possible to add favorites by clicking on the star icon next to

a register. The favorites will display the selected registers only.

Registers description of each camera is available in a separate document identified as:
‘camera_name_ Features_Reference_xxx.pdf"

5.4.Central part

Playback Buffer
[ | 2 ] [ 0/6865 ]
50 fps EIC | 0 Elﬁ
Acquisition File Left mouse dlick action Image Processing

- e ER 0

L]

o )Le ) B)L) s (P

1

427 I 8660
X: 76 Y: 256 (index: 163916) ADU: O (Screen value: 0)

Buffer: 0/6865 - FPS: 0 - Sensor Temp: 19.32 - Status: operational

Fig. 14 : Central module

This part is common to all cameras and control the images buffer, acquisition, and some image
manipulation.




54.1. Buffer

Playback Buffer
[ [ J [ 1822/6865 ]
50 fps EIC | 1822 Eli

Fig. 15 : Buffer part

The buffer part displays a progress bar of the buffer filling, a slider to manually set the image
displayed and a Playback button.

When “Save” is clicked, a new window appears to choose the part of the buffer that he wants to
save.

" Sawve Buffer ? .

start: (o = i
End: 0 EI I
Count: | 1 EI I

Nb bursts: | 1 —{ [] Multiple of bursts

 Select allimages | Decmation: (0 =]

[] Include metadata (only current configuration of the camera will be saved)

Save with offset: [[} %l [Autﬂ detectJ [] save as unsigned

[Save asJ [CancelJ

Fig. 16 : Dialog save buffer

Many options are available;
Save a multiple of burst, auto detection of the bursts.
Select all images
Apply a decimation of x images
Include metadata in file (for RAW format a file " metadata” will be added with the same name
of the RAW file)
Apply an offset on all the pixels of all the images stack.
Auto detect the value to apply for each pixel to have only positive pixels.
Force the GUI to save the pixels as unsigned.

When clicking on “Save as’, the save dialog is displayed to choose between the available saving
formats.




i Save buffer
&« v 4 =l s CePC » Images »

Organiser « MNouveau dossier

~
& cePC

B Bureau

|=| Documents

&=| Images

J] Musique enlrr:gaigtersées
) Objets 2D

& Téléchargement:
m Vidéos

‘i Disque local (C)
=g 06_Service Inforr
= 03_r&ud (\192.1€
=x tempo (\\192.16

& Récean

v

Pellicule

« O

Rechercher dans:

Images

-

o

Mom du fichier:

buffer.raw

Type:

RAW format (*.raw)

~ Masquer les dossi

FirstLightFrame format (*.flf)
_TIFF format (*.tif) l

Fig. 17 : Dialog choose file

Available formats are AVI, DICOM (plugin), FITS, FirstLightFrame, HDF5, RAW and TIFF. If you want
to add your own format as a plugin, please contact First Light Imaging at support@first-light.fr.

FirstLightFrame is a custom format defined by First Light Imaging, the file has a header of 2048
bytes directly readable in an editor and it is composed like this:

‘FirstLightFrame;Version:1.4;HeaderSize:2048;Date:XX;Nblmages:XX;CameraModel:X;Width:XX;Heig

AVl format (*.avi)
DICOM format (*.dem)
FITS format (*.fit)

ht:XX;unsigned pixeliyes/no;cropping:XX:..". InNformation depends on the camera.

This is the beginning of the file, all X are values, the header is then completed with arbitrary bytes to
have the 2048 bytes size and the images data are after.

Images stack can be loaded by using the “Load”, by right clicking on the buffer progress bar or by
dropping the file on the progress bar. When a file is loaded, a new window appears with a central

widget and an image statistics widget.



mailto:support@first-light.fr

CifUsers/jtugnoli/Desktop/buffer_27072021_102910.raw

Image Statistics | Image Processing

X: 0Y: 259 (index: 165760) ADU: 3619 (Screen value: 36)

Image Statistics El
Cube analysis [Fahe j
Depth [50 ii
Temporal standard deviation )
Mean [ )
Spatial standard deviation (760.368 )
Mean (397215 )
Min value 0 ]
Max value (14790 ]
listogram Raw | Histogram Display
600
500
»
g 00}
a
w
o
§ 300
o
E
Z
200
100 -
0 2500 5000 7500 10000 12500
ADU Value
X: 10971.49 Y: 637.34

I (o) e i)

By clicking on

Fig. 18 : Images stack window

‘Display metadata” a window with the corresponding metadata will be displayed.




- FirstLightVisien ? >

temperatures

Fig. 19 : Metadata window

5.4.2. Display
In the middle there is the display of the image. This display offers multiple functions.

Some basics image manipulations are available with some shortcuts:
Zoom in/out by keeping “Ctrl" pressed and roll the wheel of the mouse.
Move the image by keeping “Ctrl" pressed and left mouse button and move the mouse.
Rotate the image by keeping the wheel mouse button pressed and move the mouse.

Here is an example after a zoom in where you can see that the pixel under the mouse is of a
different color.




Fig. 20 : Display with mouse

Just under the display there is a line that displays useful information:

+002 I 6291

X: 194 Y: 317 (index: 203074) ADU: 4382 (Screen value: 35)
Fig. 21 : Display mouse position information

X and Y being the position of the mouse on the image, the index of the corresponding pixel, the
value of the pixel in ADU and the value of the pixel after processing.
A color scale is also available with the colors between the min value and the max value.

You can do a manual clip on the image by keeping the left click of the mouse pressed, move it and
release it in order to draw a rectangle where the clipping will be computed.

Width: 239
Height: 187
Origin: (193, 119)

Fig. 22 : Display clipping

Same thing can be done with the right click of the mouse to draw a red rectangle (analysis
rectangle) that will Limit the processing of information in “Image Statistics” module.




Width: 119
Height: 109 = °
Origin: (239, 178)

Fig. 23 : Display analysis rectangle

The analysis rectangle can be moved by pressing “Ctrl" and click on it, it also can be resized by
clicking on a border.

Some other functions are available by right clicking on the display.

% Transform 3
1 Save displayed image
=1 Save raw image
Print image
i Display infos
2 Restore image
Open new window
& Cross Section Profile
m Cropping sent by camera
Display image as number

& Copy to clipboard

Fig. 24 : Right click menu

“Transform” is a submenu to do some basic transformation on the image.




4 Transform % L3 Vertical flip
Save displayed image Horizontal flip
Save raw image @' Rotate 90 clockwise

Print image ¥ Rotate 90 counterclockwise

Display infos
Restore image
Open new window
Cross Section Profile
Cropping sent by camera
Display image as number

Copy to clipboard

Fig. 25 : Transform submenu
*Save displayed image” will save the displayed image in PNG, JPEG or TIFF.
‘Save RAW image" in order to save the current image from the buffer in RAW.
‘Print image” will start a printer preview with the current displayed image.

‘Display infos” will display some information directly on the image, if you save image with
this option enabled, they will be saved too.

Fig. 26 : Display with Display infos enabled
‘Restore image” will disable all transformations done on the image like zoom, rotation, flip,

‘Open new window" will open a window with a new display that will be independent of the
others.
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Fig. 27 : New display window

= "Cross section profile" will draw a cross section on the image and display a new window with
the pixel's values under the lines.

Fig. 28 : Display with cross section




{5 Cross Section Profile
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Fig. 29 : Cross section graph

‘Cropping sent by camera” if it is enabled then the cropping will be the true image sent by the
camera. If it is disabled, the GUI will adjust the image to the cropped zones.

‘Display image as number” will display a new window with a number representation of the
image.
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Fig. 30 : Image as number

Right click on the top left corner of the array to change the number representation between
Hexadecimal or Decimal, or export value in a CSV file.

- Display as number

= 2
Hexadecimal

5 Decimal 1012

3 Save as CSV fa2

4 100e flc fd7
5 faf feb 1045

& 1055 f2a fia

Fig. 31 : Hexadecimal or Decimal

‘Copy to clipboard” will copy all the displayed image (with form and text) to your clipboard.




5.4.3. Multiple ROIs

It is possible to add ROIs on image by clicking “Alt" + mouse left click.

Fig. 32 : ROIs

Each ROI has a default name and ROIs parameters can be accessed thanks to the new window
‘Region of interest”.




[ Console | Image Statistics | Image Processing | Regions of interest | Camera Cont...

Regions of interest 9%
MName Value
o [
Rect {112, 52, 96, 33} Rectangle area properties
Mean [15256.? ] [] pisplay on image
Alarm min [D-“D jl (| Enable/disable min alarm [alarm.mpB j
Alarm max [D-“D jl [ 1 Enable/disable max alarm [alarm.mpfl j
Spatial Standard Deviation [88-0116 ] (] Display on image
Text color [ ]
Histogram [ Show ]
v [
Rect {360, 194, 49, 79} Rectangle area properties

Mean 15294.2 [ Display on image

Spatial Standard Deviation [ Display on image

Text color

[ )

[ )

[ ]

Histogram [ Show ]
) J

[Line 2

Line {211, 260, 263, 170} Line properties

Mean [15295-7 ] [ Display on image
Alarm min [D-ﬂﬂ j| [ Enable/ disable min alarm [alarm.mpa j
Alarm max [D-ﬂﬂ j| (] Enable/ disable max alarm [alarm.mpa j

Spatial Standard Deviation [94-0203 ] (] pisplay on image

Text color [ ]

Histogram [ Show ]

Fig. 33 : Region of interest window

You can change the ROI background color and text color or display more information on image like
‘Mean” or “Spatial standard deviation” of the ROI. You can change the size and position of the ROI.
Alarm can be activated to notify the observer when the value of the parameter is not any more in the
specified range.




5.4.4. Shortcut's button

5.4.4.1 Acquisition
Acquisition

(-] (=) K3

Fig. 34 : Acquisition shortcuts

There are five buttons for this section:

starts the grab

[ ] —
—_—

pauses the grab and does not reset the buffer at next grab start

o ~—*: stops the grab and reset the buffer at the next grab start

[i. FirstLightVision ? *

Number of images to grab

36 4

Minimum time for the grabN: 0.64s
[] pon't ask me again

)
o opens a box and start a grab of N frames. If you

click on “Don't ask me again” then the box will not appear until the next software start, but you
can change the number of images in “File"->"Settings” (see section 5.6.1.2).

o B starts/stops direct record (see section 5.6.1.6).

54.4.2 File

File

%Mi} '@J

Fig. 35 : File shortcuts

—

There are three buttons for this section:

opens the dialog save buffer (see figl18)

. is used to load a file




o . takes a snapshot of the current image (see section 5.6.1.5).

5.4.4.3. Left mouse click action

Left mouse click action

2= &8

Fig. 36 : Left mouse click action shortcuts

There are five buttons in this section, each button changes the function realized by the left mouse
click on the image:

. enables the cropping section

enables to draw the image statistics rectangle

enables to draw region of interest

enables to draw section

HNElE

enables to draw a rectangle to delete regions of interest and sections
5.4.4.4. Image processing

Image Processing

clip |[ Auto |[ ararn |[ o1 1
\ Cn:pn H Clip ] anarp ﬂ LLA E]

Fig. 37 : Image processing shortcuts

There are four buttons in this section:
Clip

Once

e ' “tocliponceonallthe image

Auto
Clip

e ———'enables the autoclip on all the image

Sharp
e ' Jenables the sharpen processing

=S

Il
CLAHE

e ' “enables the CLAHE processing

Clip: Clip function is a way to automatically set the best values for the white and black points.

All the ADU above the white point will be displayed as white (RGB=255,255,255) and all the ADU
values below the black point as black (RGB=0,0,0). It is required to set these points because the
dynamic of a pixel on a screen for grayscale images is limited to [0-255] which is lower than the




dynamic of the images coming from the cameras. The clip function maps as best as possible the
dynamic of the images to the dynamic of the screen.

This mapping is linear(default), logarithmic
processing / clipping section.

or gamma depending on the type selected in the image

Sharpen: Sharpen processing is a way to increase the contrast between bright and dark region.

Clahe: Clahe processing is a way to improve the image using an adaptive histogram equalization.

5.5.Image processing

Console | Image Processing | Image Statistics | Camera Control‘
Image Processing g
Clipping
Black pixel 3827.00 EI: I
White pixel 12147.00 El: |
Clip full frame [ Execute
Auto clip [False - |
Contrast 50 El: I
Type [LINEAR "I
s
o 5001
(1] Lo
f ol
o 400
—
0
,_
Graph 16b->8b E 300 [
g _____
Z 200 —
100
| .............. B S —— e — ||
0 2500 5000 7500 10000 12500 15000
ADU Value
X: -2647.92 Y: 7715.21
Color map [NONE v|
Rotation [ﬂ' jl

Soft bad pixels False

|

Fig. 38 : Image processing tab




5.6.File menu

. FirstLightVision Version:2.0.3_beta-67-gat
File[’.Tools View Plugins |

Settings |L

*

E

Save settings

() Refresh GUI F5
= Open web server page
- Get camera logs

< Detect cameras

5 Mode »

Fig. 39 : File menu

5.6.1. Settings

Buffer
Size (images) [ 7366 jl
Size (Mo) (4604 -
Display [True T |

Fig. 40 : Buffer settings

In this section the user can change the size of the buffer (in number of images or in Mo) and choose to
display the buffer part in the central view.

Grab
Nb images per buffer [1 il
Auto start [False vl
Substract Mode [False v|
Burst filter [ -1 il
GrabN count [25'5 il

Fig. 41 : Grab settings

In this section the user can:
Change the number of images per buffer (useful for high FPS).
Auto start mode, if enabled then the grab will start automatically when the software start.
Substract mode, if enabled then the image is a substraction of the image N minus the image
N-1, the subtracted image is saved in the ring buffer,




Burst filter, when tags are enabled and IMRO mode is enabled, the burst filter will display only
the images with a burst tag of the indicated value.

Camera
Detection [ Start J
Selection [ CRED2#01-00001643af9e#Matrox-Dev_0 h |
Poll interval [1 S jl
Enable Polling [True "I
Ethernet [ Add J

Fig. 42 : Camera settings

In this section the user can:
Start a camera detection.
Change the camera used.
Change the polling interval.
Enable/disable the polling.
Add an ethernet camera:

[i. FirstLightVisi... ? 4

1P Address
169.254.123.123|

Login
[ admin ]
Password
[ flicred1 ]

[ Automatic detection ]

Fig. 43 : Add ethernet camera

This feature makes possible the use the GUI through an ethernet connection to the camera. By
clicking on it you will have to enter the IP and the login/password of the camerai.

Once the connection is done all features of the GUI are available but with a grab FPS lowered
(around 25-30 FPS).




You can set a range of IP in order to auto detect a camera on the same subnetwork (only class C
network), example: 192.168.100.20-60

This will send a ping to all the IP between 192.168.100.20 and 192.168.100.60, and will compare
the MAC address to the known range of our camera MAC address. *“Automatic detection” button will
do a detection for all the range of the subnet.

User Interface
Configuration [Full -
Theme [Wh'lte -
Hide logo [True d
Mode [Exper‘t d

Fig. 44 : User interface

In this section the user can:
Change the software configuration (full, grab only or control only).
Change the software theme.
Hide/show the logo.
Change the software mode (basic or advanced).

The software has 3 modes of operation:

In “Full” mode, the software displays all the modules and the captured frames.

In “Grab only” mode, the software displays the captured frames and Image Statistics module
only.

In “Configuration only" mode, the software displays the camera configuration modules,
‘Console”, “Camera Status" and “Camera Parameters” only. In this mode, frames from the
camera can be captured by another software.

Snapshot
Image type [Raw image - |
Path [ C:/Users/jtugnoli/ Documents ] @
File name [snapshut ]
Format [FITS - |

Fig. 45 : Snapshot

Q.
These are the parameters used when a snapshot is taken with the button .




5.6.16. Record

Record

Path C:/Users/jtugnoli/ Documents ]

File name record
Number of frames 100
Estimated size 62.5 Mo

-

Estimated bandwidth |99.3752 Mo/s

Metadata False

Disk benchmark Run

U U e UE)

[
[
[
[
Decimation [
[
|
|
[

Calculated bandwidth | 2503.13 Mo/s

Fig. 46 : Record

These are the parameters for a direct record with the button B . User must select path, file
name, number of frames to save, the decimation and enable/disable metadata.
By clicking on “Run’, a benchmark of the path will be done to know the maximum bandwidth
available then user must adjust the parameters to fit the estimated bandwidth to the calculated
bandwidth.

5.6.2. Save settings
Click on "Save settings” to save settings and apply them at the next startup.

5.6.3. Refresh GUI
Click on “Refresh GUI" (or F5 shortcut) to reread camera parameters.

5.6.4. Open web server page

For compatible cameras, this button will activate the web server on the camera and open a web
page using default browser.

5.6.5. Get camera logs

Click on “Get camera logs" to download logs file from camera.

. FirstLightVisi.. 7 *

Nb days: tl =

This window will appear, enter the number of days to compose the logs

file and click "Ok" to download it.

5.6.6. Detect Cameras

A shortcut for camera detection.




5.6.7. Mode

5 Mode s P v I|I=u||

Grab Only

Configuration Only

1

The software has 3 modes of operation:

In “Full” mode, the software displays all the modules and the captured frames.

In “Grab only" mode, the software displays the captured frames and Image Statistics module
only.

In “Configuration only" mode, the software displays the camera configuration modules,
‘Console”, and “Camera Control” only. In this mode, frames from the camera can be captured
by another software.

5.7.Tools menu

. FirstLightVision Version:2.0.1_beta-dirty Model:

File Tnnls?]“f-'iﬁew Plugins Help
|* Temperatures Graphics

Plg 1
Firmware upgrader |

-.-'#'

a0 License Manager

| Bad Pixels Correction k

-/ Camera status logger y
# Measure Camera Charac =
*! Scripting

" Camera preset 4

Fig. 47 : Tools menu

5.7.1. Temperatures Graphics

This option displays a new window with a graphic of camera temperatures since the opening of the
graph.
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Fig. 48 : Temperature graphics

5.7.2. Firmware upgrader

This option displays a new window for the camera maintenance.

[ Firmware upgrader — O x

[Enter firmware URL (ex http://myHosbootar.gz file) ] @ [Send] [Ahnrt]

Fig. 49 : Camera maintenance

The camera's firmware can be easily upgraded using the application. Firmware being transferred to
the camera using TCP/IP, ensure that the camera is properly connected to IP network before

performing the upgrade.




The current IP configuration of the camera can be displayed by typing “ipaddress” command in the
main application console.

[16:44:30]1fli-cli> ipa

MAC ADDRESS:70:B3:D5:B0:920:17 IP ADDRESS:152.16€8.120.3% MASK:255.255.255.0
LINE ESTABLISHED:yes

oK

Fig. 50 : Console IP address example

To perform the update, the firmware can be either hosted on a server (http, ftp or tftp) accessible by
the camera, or directly on the PC controlling the camera.

When the firmware is hosted on a server, simply write the URL of the firmware in the upgrade
firmware entry and click “Send" to proceed.

The "Abort” button abort the current update procedure. This is typically used when the specified URL

is invalid or unreachable. It is used to unblock the FW camera download procedure.

When the firmware is located on the PC, click on the [;] button to select the firmware file. Once
selected, the firmware file location will appear on the text entry.

Then click “Send". The application will directly upload the firmware file into the camerai.

The firmware update progress will be shown in the application console. In case of successful
installation, the camera reboots automatically to use the new firmware.

C-RED 2-3
754 UpgradeC-RED2-3firmware

5.7.3. License Manager

This option displays a new window to manage the camera'’s licenses.




- License Manager — 0 Y

Send license file into the camera

|

[Select a file from your computer ] [ ] [Send

Transfer file using XModem protocol

License files already on the camera

hdr.lic Enable

il

Disable

Delete

Fig. 51 : License manager

Camera optional features are enabled using license files uploaded into the camera.
The license manager window upload, enable, disable or remove license files.

To upload a license file into the camera, select the file by clicking the button @ .

Click on “Send", the file will be automatically sent to the camera using the serial link.

The checkbox “Transfer file using XModem protocol” specify the transfer protocol (XModem or raw).
To reenable a currently disabled license (appears in the list with a “disabled” suffix), select it and
click on the button “Enable”.

To disable a currently activated license (appears in the list without “.disabled" suffix), select it and
click on the button “Disable”.

To remove a license file, select it and click on the button “Delete”.

The button “Refresh’ refresh the list of license files installed in the camera.

Changes on license files will only be active after a camera reboot. It is recommended to restore the
camera factory settings to keep the camera configuration consistent when enabling/disabling the
600fps option.




{5 Bad Pixel Editor

5.7.4. Bad pixels editor

This option displays a new window to edit the bad pixels user map. The bad pixels editor is not
available for C-RED 2 ER, C-RED One and C-BLUE One.

g X: 274 ¥: 55 (index: 35474) ADU: 10256 (Screen value: 128)

Clipping

Black pixel 9075.00 3: 1

White pixel 11577.00 Eli 1

Clip full frame [ Execute ]
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Graph 16b->8b

0.2

1] 2500 5000 7500 10000 12500 15000
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User map

Display . Keep "ALT" pressed to edit.

(Load from camera | _Load from file | (save to file |

ony o

Fig. 52 : Bad pixel editor

First thing to do is to enable “Display” checkbox and click on the “Load from camera” button to
display the user map of bad pixels. This map will appear with green pixels by default, but the color
can be changed by clicking on the colored button next to “Display” checkbox.

‘Reset map" button reset all the map. To edit the map, keep “Alt" pressed and left click on pixels that
you want to choose as bad pixels. By keeping the left click pressed you can choose pixels just by
passing on it.

If you click on a pixel already in the map, then it is deleted. It possible to delete pixels from the map
with a rectangle selection, keep “Shift" pressed and draw a rectangle with the left click of the
mouse, all pixels in the map that are in the selection will be deleted.

‘Load from file" load a map from a selected file in the computer.
‘Save to file" save the map on a file in the computer.

‘Copy factory” will copy the factory map of the camera.

‘Save to camera” will update the user map in the camera.

Note: To restore the factory map, click on "Copy factory”then on “Save to camera’.




5.7.5. Bad pixels detection wizard

Available for C-RED 2 and C-RED 3 only.

This will open a wizard that will guide you to build a custom bad pixel map. At the end it will also
provide some options to improve the image quality.

The first step is to put the camera in the configuration you want to use.

. Bad Pixels Detection Wizard — O >

Welcome to the bad pixel configurator !
This wizard will guide you step by step to create your bad pixel map.

Step 1/7

The camera is currently in the following configuration. You may edit the
parameters if you wish to find bad pixels in another configuration.

Framerate [ 159.00 fps jl [ Set fps max:403.746 ]

Exposure [6.23 ms il [Set tint ma)(:li.28159]

N

DarkOptim level | 0 -

Tuning general - I
Conversion gain | high - I

Cooling Il[l oC

Fig. 1: Bad Pixels Detection Wizard step 1/7




& Bad Pixels Detection Wizard

Step 2/7
In dark condition, the pixels from an image stack deviating from the average value will be classified as bad pixels.

1. Put the camera in the dark

2. Select the number of frames to be studied

3. Press "Grab" to start acquisition

4. Visualize the bad pixels marked in red on the left panel

5. Tune the thresholds in the right panel (by default +/-30% of the average value)
6. Once you are satisfied of the detected bad pixels, move on to the next step

Nb images | 50 3 Estimated time for grab: 0.124066s

Images Stack (bad pixels added in the map are red). Select limits for pixels that you want to add in the bad pixels map.

25000

15000

10000

5000

e e L TR | o | e
1000 2000 3000 4000 5000 6000 F000

ADU Value

Min Threshold ’ Max Threshold
2741 = 5092 =

s | = 3

i i

Previous

X: 608 Y: 0 (index: 608) ADU: 2325 MEAN: 3935.92

Fig. 2. Bad Pixels Detection Wizard step 2/7

With the camera in the dark, a first criterion, based on the level is provided to detect the bad pixels.
The default thresholds usually provide good results, but if needed, it is possible to adjust them.




(i Bad Pixels Detection Wizard - = X

Step 3/7

In dark condition, the pixels whose temporal variation is above average will be classified as bad pixels.
The stack of images acquired at step 2/6 is re-used.

1. Visualize the bad pixels marked in red on the left panel
2. Tune the thresholds in the right panel
3. Once you are satisfied of the detected bad pixels, move on to the next step

Temporal Standard Deviation map. Select limits for pixels that you want to add in the bad pixels map.

Pixel temporal standard deviation

25000

15000

10000

5000

n T R T e e e
0 25 50 100 125
ADU Value
Min Threshold [ Max Threshold
( 2.00 = | 130.46 -
X: 0 Y: 0 (index: 0) ADU: 14 MEAN: 32.1147 I I

Fig. 3: Bad Pixels Detection Wizard step 3/7

With the camera in the dark, a second criterion, based on the noise is provided to detect the bad
pixels.
The default thresholds usually provide good results, but if needed, it is possible to adjust them.




.- Bad Pixels Detection Wizard — O b4

Step 4/7 (optionnal)
Under a flat field illumination, the pixels from an image stack deviating from the average value will be classified as bad pixels

1. Set a flat field in front of the camera. The mean value should be between 8000 and 9000 ADU.
2. Select the number of frames to be studied

3. Press "Grab" to start acquisition

4. Visualize the bad pixels marked in red on the left panel

5. Tune the thresholds on the right panel (bu default +/-30% of the average value)

6. Once you are satisfied of the detected bad pixels, move on to the next step

Nb images | 50 EI: Estimated time for grab: 0.124066s

Images Stack (bad pixels added in the map are red). Select limits for pixels that you want to add in the bad pixels map.

Mumber of pixels

2000

Min Threshold Max Threshold

[ 0 = 0 =

X: 639 Y: 307 (index: 197119) ADU: 3697 MEAN: -5.71875

Fig. 4. Bad Pixels Detection Wizard step 4/7 (optional)

With the camera in front of a flat field, a third criterion, based on the level is provided to detect the

bad pixels.
The default thresholds usually provide good results, but if needed, it is possible to adjust them.




.- Bad Pixels Detection Wizard
Step 5/7 (optionnal)

Under a flat field illumination, the pixels whose temporal variation is above average will be classified as bad pixels.
The stack of images acquired at step 4/6 is re-used.

1. Visualize the bad pixels marked in red on the left panel
2. Tune the thresholds in the right panel
3. Once you are satisfied of the detected bad pixels, move on to the next step

Temporal Standard Deviation map. Select limits for pixels that you want to add in the bad pixels map.
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Fig. 5: Bad Pixels Detection Wizard step 5/7 (optional)

With the camera in front of a flat field, a fourth criterion, based on the noise is provided to detect the

bad pixels.
The default thresholds usually provide good results, but if needed, it is possible to adjust them.




Bad Pixels Detection Wizard - O X

Step 6/7

Total number of bad pixels: 896
Percentage of bad pixels: 0.273438%.

Select the maps that you want to add to the final map.

Dark stack map
Dark StdDev map

Fig. 6 : Bad Pixels Detection Wizard step 6/7 (optional)

This step summarizes the detected bad pixels. The bad pixels detected for each criterion are
displayed as different layers.




. Bad Pixels Detection Wizard

Step 7/7
Option 1
Send the map to the camera, put the camera in the dark and build the bias.

Enable correction [] Enable bias

Option 2

Save the map in a file and open it with the bad pixels editor

In addition you can enable some image processing. (this will close this window).
[ sharpen [ Clahe
And find the good clipping.
2 R Save and open editor]
] Auto Clip——
Contrast | 50 —

[ Start/Stop ]

Fig. 7. Bad Pixels Detection Wizard step 7/7

At the end, if you agree with the bad pixels map, you can send it to the camera. Otherwise, you can
edit the map in the bad pixels editor to remove or add some specific bad pixels.

In case you agree with the bad pixels map, it is recommended to build the bias, enable the image
processing and the clip option to directly get the best image.




5.7.6. Bad pixels Matrix Convolution

The bad pixels Matrix Convolution is only available for C-RED 2 Lite and C-RED Three.
This tool displays a new window where the user can vary the matrices' coefficients, their divisor value
and which kind of bad pixel correction to apply:

| i+ Divisor and Matrix for Bad Pixels ? X

This is the current matrix of badpixels correction, you can modify it and send it to the camera
n® 1 | Empty convolution matrix j
List of matrix index
Read values from camera ] (5x5 -] Size of the matrix
List of matrix models
Gaussian Filter
1 o 0 0 o
Average Filter
Sobel X Filter
Sobel Y Filter
0 4 0 0 0 Identity Filter
0 o 0 0 o
0 o 0 0 o
[] Exdlude borders
0 0 0 0 0 [ Send the matrix to camera J
Bad Pixels mode selection
[Low latency bad pixel correction j
Divisor value
N Ii
[ normalize [] Apply BadPixel correction

Fig. 8 : Bad Pixels Convolution Matrix Window
The drop down menu at the top lists 10 matrices, numbered O to 9. The O matrix cannot be modified

by users : it is the default matrix for First Light Vision. Its cells have a grey background to signify that.
The other 9 matrices are completely user customizable.

This is the current matrix of badpixels correction, you can modify it and send it to the camera |

n° 0 | Empty convolution matrix j

List of matrix index
Read values from camera J 5x5 ~| size of the matrix

List of matrix models

Gaussian Filter
Average Filter
Sobel X Filter
Sobel Y Filter

© e
% liter

0 1 0 | 2 FirstlightVision

The matrix of index 0 cannot be modified

; ; |

[ Exclude borders

0 0 0 0 0 [

Send the matrix to camera ]

Bad Pixels mode selection

[Low latency bad pixel correction j
Divisor value

[E] normalize 1

] Apply BadPixel correction
Fig. 9: Matrix index O cannot be modified




The “Read values from camera” button is used to get the value recorded inside the camera for the
selected matrix. For matrices 1 to 9, the values of the cells can be changed manually by clicking on a
cell and entering a new value. A list of default matrix models is available for matrix sizes 5x5 or 3x3.
3x3 has more default models available.

[ n° 4 | Empty convolution matrix j
List of matrix index
[ Read values from camera ] 5%5 j Size of the matrix
List of matrix models
Gaussian Filter
1 1 1 1 1
Sobel X Filter
Sobel Y Filter
1 1 1 . . Identity Filter
1 1 1 1 1
1 1 1 1 1
1 1 1 1 1
Divisor value
[E] Normalize
Fig. 10: 5x5 models list
n? 4 | Empty convolution matrix j
List of matrix index
Read values from camera ] m Size of the matrix
List of matrix models
Gaussian Filter
0 0 0 0 0
Average Filter
Sobel X Filter
0 0 A 0 0 Sobel Y Filter
Prewitt X Filter
Prewitt Y Filter
Identity Filter
0 1 5 1 0
0 ] -1 0 0
0 0 0 0 0

Divisor value
[E] Normalize

Fig. 11 : 3x3 models list

3x3 matrices are treated as 5x5 matrices with the borders coefficients forcibly set to O. These border
cells are unmodifiable and have a grey background to signify that.




By default, the value of the divisor is normalized to the sum of all the cells. The user can uncheck the
Normalize check box to enter a different value. The divisor value will be used to divide the values in
all the cell. For example, with cells all filled with 1 (Identity filter), setting the divisor value to 2 will
divide all the pixel values by 2. Setting it to 0.5 will multiply all the pixel values by 2.

Once the matrix is properly configured, the user can send it to the camera with the “Send the matrix to
the camera” button. The user can then select the Bad Pixels Mode inside the drop-down list in the
bottom-right:

- Divisor and Matrix for Bad Pixels ? X

This is the current matrix of badpixels correction, you can modify it and send it to the camera

n? 2 | Empty convolution matrix j
List of matrix index
Read values from camera J 3x3 =] size of the matrix
List of matrix models
Gaussian Filter
0 0 0 0 0
Average Filter
Sharpen Filter
Sobel X Filter
0 0.0605 5432 0.0605 0 Sobel Y Filter
Prewitt X Filter
Prewitt Y Filter
Identity Filter
0 54432 489.99 54432 0
0 0.0605 54432 0.0605 0
[ Exclude borders
0 0 0 0 0 [ Send the matrix to camera J
Bad Pixels mode selection

Low latency bad pixel correction j
Divisor value

& N i Low latency bad pixel correction
ormalize 512 Convolution bad pixels correction

Fig. 12 : Mode selection

‘Low latency bad pixel correction” is the mode that does not use matrix convolution (legacy mode).
‘Convolution bap pixel correction” will apply the selected matrix convolution.

At the bottom of the window, the “Apply Bad Pixels correction” check box activates the correction. The

bad pixel correction in “Convolution bap pixel correction” mode can only be activated if there is no
filtering already ON (see next Section).

The last check box, “Exclude borders”, will make the correction ignore the border of the frame: the first
line, last line, first column and last column. This border often has abnormal pixels values and may
disturb the correction. This exclusion is made by setting an arbitrary O value (black) for these pixels
when correction is applied, if the “Exclude borders" check box is checked.




5.7.7. Filtering

The Filtering shares the same convolution matrix as the bad pixels correction but applies the
convolution to every pixel instead of just the selected bad pixels.

Functionalities are mostly the same as the bad pixel Tool, except for the bottom right part of it that
will be specific to the filtering:

- Divisor and Matrix for Filtering ? X
|
This is the current matrix of filtering correction, you can medify it and send it to the camera
n? 4 | Empty convolution matrix j
List of matrix index
Read values from camera ] 3x3 ~| Size of the matrix
List of matrix models
Gaussian Filter
0 1] 0 0 0
Average Filter
Sharpen Filter
Sobel X Filter
0 ; . 1 0 Sobel Y Filter
Prewitt X Filter
Identity Filter
0 0 ] 0 0
0 1 -1 1 0
[] Excdude borders
0 o 0 0 0
Send the matrix to camera ]
Divisor value
[E Hormalize :] [ Filtering On/Off

Fig. 13 Filtering

The change concerns the different modes available with the bad pixel correction. Here, there is only

the “Filtering On/Off" check box. Checking this box will activate the filtering and unchecking it will
deactivate it.

Filtering can only be activated if there is no bad pixel correction activated in the “Convolution bap
pixel correction” mode.




5.7.8. Camera status logger

This option will start the log of some camera parameters that are displayed in the GUI. It will ask you
for the file name to save the information.

" logs.txt - Bloc-notes — [m| *

Fichier Edition Format Affichage Aide

rl'ime;Spatial Dev;Temporal Dev;Average;Mean;MB (°C);FE (°C);PW (°C);SENSOR (°C);PELTIER (°C);HEATSINK (°C);IntPower (W);ExtPower (W);Status;
31/85/2021 16:20:41;177.997;177.997;3428.59;0;41.25;45.00;41.75;19.98;30.52;32.71;0.25;8.42;0perational;
31/85/2021 16:20:42;177.997;177.997,;3428.59;0;40.75;44.75;41.75;20.02;30.52;32.71;0.24;0.42;0perational;
31/05/2021 16:20:43,177.997;177.997;3428.59;0;40.75;45.25;41.75;20.02;30.52;32.72;0.25,0.42; cperational;
31/85/2021 16:20:44,177.997;177.997;3428.59;0;41.00;45.50;42.00;20.02;30.52;32.72;0.25,0.42; cperational;
31/85/2021 16:20:45;177.997;177.997,;3428.59;0;41.80;45.50;42.00;20.02;30.52;32.72;0.25;0.42;0perational;
31/05/2021 16:20:46,177.997;177.997;3428.59;0;41.00;45.00;42.00;20.00;30.52;32.72;0.24,0.42;cperational;
31/85/2021 16:20:47,177.997;177.997;3428.59;0;41.25;44.75;42.00;19.98;30.52;32.72;0.25,0.43 ;0perational;
31/85/2821 16:20:48;177.997;177.997,;3428.59;0;41.25;45.25;42.00;19.98;30.52;32.72;0.25;0.43;0perational;
31/05/2021 16:20:49;177.997;177.997;3428.59;0;41.25;45.25;42.00;19.98;30.52;32.72;0.25;0.43 ;0perational;
31/05/2021 16:20:50,177.997;177.997;3428.59;0;41.00;45.25;42.00;208.00;30.52;32.72;0.25,0.42;cperational;
31/85/2821 16:20:51;177.997;177.997;3428.59;0;40.75;44.75;42.00;20.01;30.53;32.72;0.24;0.42;0perational;

Ln1, Col1 100%  Unix (LF) ANSI

Fig. 14 : Logger file example

The file can be renamed with a “.csv” extension to open it with Microsoft Excel.

Enregistrement automatique PR O Rechercher Julien TUGNOLI T
Fichier Accueil Insertion Mise en page Formules Données Révision Affichage Aide I% Partager 1 Commentaires
flﬂ X Calibri dn DA A== E e , Standard  ~| | G Mise en forme conditionnelle~ | & Insérer ~ - %? p E?
E@ - g ~ 9p o [Z Mettre sous forme de tableau ~ X Supprimer ~ B~
Caoller G I § ~ M. A == = - - . Trieret Rechercheret | Analysede
. ¥ = =T | =F=E===1=" %4 I Styles de cellules ~ £ Format ~ &~ filtrer~ sélectionner~ | données
Presse-papiers & Police F Alignement ~ Mombre ] Styles Cellules Edition Analysis ~
G22 - 5 v
A E = D E F G H | pl K L M N -
1 |Time Spatial Dev Temporal De Average Mean MB (°C) FE(°C) PW (°C) SENSOR (°C) PELTIER (°C) HEATSINK (°(IntPower (W ExtPower (W Status
2 31/05/2021 16:20 177.997 177.997 3428.59 041.25 45.00 41.75 195.98 30.52 3271 0.25 0.42 operational
3 31/05/2021 16:20 177.997 177.597 3428.59 0 40.75 44.75 4175 20.02 30.52 3271 0.24 0.42 operational
4 31/05/2021 16:20 177.997 177.597 3428.59 0 40.75 45.25 41.75 20.02 30.52 3292 0.25 0.42 operational
5 31/05/2021 16:20 177.997 177.897 3428.59 0 41.00 45.50 42.00 20.02 30.52 3agz2 0.25 0.42 operational
6 31/05/2021 16:20 177.997 177.597 3428.59 0 41.00 45.50 42.00 20.02 30.52 3292 0.25 0.42 operational
T 31/05/2021 16:20 177.997 177.897 3428.59 0 41.00 45.00 42.00 20.00 30.52 3a.72 0.24 0.42 operational
8 31/05/2021 16:20 177.997 177.997 3428.59 0 41.25 44.75 42.00 19.98 30.52 32.72 0.25 0.43 operational
) 31/05/2021 16:20 177.997 177.597 3428.59 041.25 45.25 42.00 15.98 30.52 3272 0.25 0.43 operational
10| 31/05/202116:20 177.997 177.997 3428.59 041.25 45.25 42.00 13.98 3052 3agz2 0.25 0.43 operational
11| 31/05/202116:20 177.997 177.597 3428.59 0 41.00 45.25 42.00 20.00 30.52 3292 0.25 0.42 operational
12| 31/05/202116:20 177.997 177.897 3428.59 0 40.75 44.75 42.00 20.01 30.53 3a.72 0.24 0.42 operational
1 -
logs ® [ 3
Prét ] - 1 + :

Fig. 15 : Logger file with Excel




5.7.9. Measure Camera Characteristics

This option opens a new window to run some measurements on the camera. Three modes are
available: Dark, PTC and Noise.
In addition, for C-RED 2 and C-RED 3 the measurements can be made for each sensitivity.

i Measure Camera Characteristics — O x

NHumber of points Number of images per points Nb images before  Type

_] > I 10 = [oark 7]

High Medium Low
System gain System gain System gain
( 2.30 = 7.80 = 90.00 -
Start tint Start tint Start tint
[ o0.00ms = [ o0.00ms = [ o.00ms -
End tint End tint End tint
[ oooms H [ oo0oms = [  oooms
Result Result Result
[ ) ) )
[ Compute ] [ save results
8000

Lo High Gain
6000 o Medium Gain.......

[ o Lows Gain
4000 — :

[2lr-] aaan]

Mean (ADU)

2000

Fig. 16 : Measure Camera Characteristics window

For all modes there are three common parameters:
‘Number of points” is the number of points between the “Start tint" and the “End tint", for each
point the exposure time of the camera will be automatically changed. Please ensure to set an
FPS that can go at the “End tint" value.
‘Number of images per points” is the number of images for each point.
‘Nb images before” is the number of images that are thrown before the images used for the
processing. With a low FPS the waiting time can be very long.




5.7.9.1 Dark computing

High ——U Medium

2.30

900.00 ms

288.575 e-/s 439.13 e-/s 901.195 e-/s

Compute M Save results

e
e P =] 2
o [ e

tint (s)

(=]
®

663.945 Clear all

Fig. 17 : Dark computing example

To do a dark measurement you need to put a cap on the camera.

Choose an integration time range well below the saturation and press compute.

The picture above is an example, but usually the suited integration time is not the same for the
different sensitivity. Usually, the higher the full well, the greater the integration time must be.




5.7.9.2 PTC computing

& Measure Camera Characteristics peiy O *

5

——B Medium

30.00 ms

19.00ms —

2.68961 e-/ADU 0.13218 e-/ADU 105.79 e-/ADU

Compute B Save results

3
g
-
T

Means (ADU)

9365.85 Clear all

Fig. 18 : PTC computing example

The photon transfer curve is a method used to find the system gain of a camera.

This tool uses this method, it plots the variance versus the illumination level and from the slope
computes the system gain.

To vary the illumination, different integration times are used on a constant illumination source.

To do this measurement, the camera must look at a uniform flat field. The ideal tool is an integration
sphere, but it is not always available. Usually, as simple sheet of paper in front of the camera
(without objective) gives good results. The min level should be above the read noise and max level
far below the saturation.

Note: The PTC method is very sensitive to the flat field used and its stability. The tool is
provided for convenience, but the user should rely on the system gain values provided in
the camera test report which are made in controlled environmental conditions (black
box, integration sphere, ..).




5.7.9.3. Noise computing

& Measure Camera Characteristics

=]
=

& High —8 Medium——

0.05 ms r 0.05 ms

Compute B Save results

tint (s)

0.00941359

Fig. 19 : Noise computing example

To do a noise measurement you need to put a cover on the camera.

The noise is computed making an average of the temporal standard deviation of all the pixels.
Using the tool, you can compute this value for various integration time.

The depth of the cube used to compute the temporal std is indicated by “number of images per
points”.

The higher the depth, the more accurate the result, but usually 50 already provides good values.




5.7.10.Scripting

This option opens a new window to run scripts to control the camera and the GUI.

[& Script - a X | @ seript - O X
O with File with File
[ ) [ )
Raok path [C:/Users/jtugnoli/ Documents ) @ Root path [ ci/ | @
suffix path | | Suffix path | |
With Server [ with Server
[ Stop ] IP : 192.168.120.31 port (4000 [ Start ] P Port [:]
Garem s

Fig. 20 : Scripting window

Two modes are available:
*With file" select a script file and start it.
"With server” to send a script through a TCP/IP connection.

The commands to use in both modes are identical and described below.

The commands available are:
‘rootpath x" sets the line edit "Root path” to x.
‘suffixpath x" overwrites the line edit suffix path to x. By default, suffixpath is set to
scripthame/date/time.
‘echo X" do an echo of x in the logs window.
‘sleep X" sleeps during x ms.
‘wait x" waits an action from the user while displaying the x message.
‘resetbuffer” resets the GUI buffer.
‘grabN x" starts a grab of x images.
‘saveframes x y" saves x frames to the file rootpath /suffixpath/y
‘camerainfos y" saves camera infos to rootpath/suffixpath/y.
‘cam x" sends the command x to the cam and return the result (see the camera
documentation to see the available commands).
“tint [x or maxl]" sets the integration time or the maximum integration time for the current fps.
“fps [x or max]" sets the fps or the maximum fps for the current geometry.
‘counterror” returns the detected grab errors.”
‘logparameters”: records all the parameters of the camera (temperatures, power, status, ..).

In addition, 3 tags are available to ease the suffixpath building.
#SCRIPTNAME# is expanded as the script name.

#DATE# as the current date.

#TIME# as the time at the script start up.




For example, the command:
Suffixpath = #SCRIPTNAME#/#DATE#/#TIME#
set Suffixpath to its default value

Remark: Fps and tint can also be set using the “cam” command, but the max argument is not valid in
this case, and numeric value must be provided.

Note 1: The TCP connection is completely independent of the scripting language used.
Any language capable of opening a TCP socket (and most of them can do it) can be
used. The TCP socket can also be used to execute the scripts on a PC other than the one
which gets the data. For convenience, a text file script is also available, but it should be
reserved for very simple scripts as it does not provide any control structure such as
variable, loop, test ...

Note 2 Another possibility to write scripts is to use the FliSdk. In that case, First Light
Vision is not needed. Some wrappers are available for two script languages, Python and
MatLab. If your favourite scripting language is not one of them, you can write a wrapper

for it from the FLiSdk.dll or use the First Light Vision scripting through TCP feature.

Below are provided 2 very simple examples.




set tcpchan [socket 1;
puts Stcpchan "echo Hello word"; flush Stcpchan;

puts "192.168.100.27:4000 answer [gets $tcpchan]";

puts Stcpchan "cam fps raw";flush Stcpchan;
camera

puts "192.168.100.27:4000 answer [gets $tcpchan]";

close Stcpchan;

H o HE

Connect to the GUI tcp socket
Send a dummy command

Receive a string

Send a fps command to the

Receive a string
Close the GUI tcp socket

s Ty v T T T T Ty
- Ktcltk86-8.6.10.5.4cl86.Win10.x86_64\tcltk86-8.6.10.5.tcl86.Win10.x86

» set tecpchan [socket 192.168.16060.27 4800081;
=ockBBBABBAAE1 DCA4CAH

% puts Stcpchan "echo Hello word";flush $tcpchans;

w puts "192.168.1688.27:48080 answer [gets Stcpchanl';
192 _168.16068.27:4888 answer OK

% puts Stcpchan "cam fps raw";flush Stcpchans;

@ puts "192.168.1688.27:48080 answer [gets Stcpchanl;
192 .168.16808.27:40800 answer 6H8.H013176006:0K

» close Stcpchans;

Z

- With Server

Stop

Connect to the GUI tep socket

Send a dummy command
Receive a string

Send a fps command to the camera
Receive a string

Close the GUI tcp socket




5.710.2 Very simple acquisition text script

# Acquisition script example

# Default
suffixpath:#SCRIPTNAME#/#DATE#/#TIM
E#

resetbuffer

# Overwrite default suffix path
suffixpath
#SCRIPTNAME#/#DATE#/#TIME# infos
camerainfos camInfos.txt
logparameters

suffixpath
#SCRIPTNAME#/#DATE#/#TIME# 200fps
fps 200

tint max

grabN 50

saveframes 50 frames.raw

suffixpath
#SCRIPTNAME#/#DATE#/#TIME# 200fps
cam set fps 100

cam set tint 4.994839

grabN 50

saveframes 50 frames.raw

With File:
K:[caracterisation [ testCam /verySimpleScript.txt

K:/caracterisation/testCam
vervSimpleScriot/2020 10 13/18 32 59 200fps

M with Server

Clear logs

Save logs




5.7.12.Camera preset

You can save some parameters of a camera in a file and load it in another camera to have the
same parameters.

When you save the configuration the camera type and hwuid will be concatenated in order to
generate a file name with the extension “fliconf". This file can be read and edited with a simple text
editor and it is in a JSON format.

"cameraModel™: 2,
"parameters™: {

"AGC": {

”chl”
”chE L

fpriority™:

”IDWl L
”IDWE L

Tztate™:

i

TaduDff=et™:

"antiBloomingState™:
"badPixelState™:

"biasState™:

"oconversionGain™:

"oropping™:
"coll™:
"ocol2™:
"rowl™:
"row2™:
"state™:

fr
"

C'r
639,
"NDTIE",-
C'r
511,

fal=e

C'r
false,
true,
false,
"hig’n”,
{
C'r
639,
C'r
511,

fal=e

darkCptimlevel™: 0,

Texposure™: l.e6el4e9,
"extSynchroExposure™: "external™,
"extSynchroState™: false,
"factoryState™: false,
PflatState™: false,

"framerate™: 600.013176,
"hdrCalibrationMode™: "off"™,
"hdrExtendedState™: false,
"hdrState™: false,
"mbFramesPerSwirig™:
"mbReadWoReset™: 1,
"rawlmagesState™: false,
"awSynchroState™: false,
Ttuning®™: "general"™

1,

Fig. 21 : Camera configuration file example




5.7.13.Hotpixel Correction

You can use the "HotPixel correction” tool to preview and configure the Hotpixel correction of the
camera.

" Hot Pixel Correction ? *

Load Images From :

From Buffer ][ From Raw file ]

When you open the Hot Pixel Correction interface you need to chose between working with data from
a file or from the current buffer of FirstLightVision.

Once the source is selected the interface will open the wizard for previewing the correction the
camera will apply on the image.
You can configure some parameters :
The threshold, in percentage of the median of the pixel, for when to use the filter on the pixel.
If you want to activate the correction with the threshold
If you want tot activate the pixel saturation correction
You can chose to preview on the image the correction or on half the image.




Hot Pixel Correction ? X

X: 1632 Y: 3385 (index: 18036912) ADU: 305 (Screen value: 10) Median Filtering
| Coefficient (5.0000 =

L
=1

[ Interval correction
[ saturation Correction

Display Setting
[ Preview  [H] Half

=

If you press the “Save To Camera” button it will close the interface and send the parameter to the
camera (threshold value, threshold activated or not, etc ..).
If you just close the interface no parameters will be send to the camera.




5.8.View menu

i FirstLightVision Version:2.0.1_beta-dirty Model: CRE

File Tools | View [-Plugins Help

Playback {¥  Image Statistics |
[I] 4 Image Processing i
50 fps ::l v  Camera Control
v  Console |

[ 5 Display Al F9 I

Fig. 22 : Display menu

This menu show/hide panels of the software and to display all (F9 shortcut).
5.9.Plugins menu

[z FirstLightVision Version:2.0.1_beta-dirty Model: CRED2  Hw

File Tools View | Plugins :g‘-HElp

Playback 3D Histogram i

[ > ]I Image Processing

|
Fig. 23 : Plugins menu

5.9.1. 3D Histogram (optional)

This option displays a new window with a 3D bar chart of the image or the analysis rectangle (see
section 5.5.2). This window could slow the software.

(i 3D Histogram

Fig. 24 : 3D histogram




The graph can be moved with the mouse right click and zoom in/out with “Ctrl" and mouse wheel.

5.9.2. Image Processing

. Image Processing — O w0

prons ) (boe) prom ] (sve)

Filters | Common | Tone Happing‘

Filters (can slow down the application)

Denoising |

(1 Enable

H coeff: | 3.00 3: Template Window Size: | 7 3 Search Window Size: | 21 3

Sharpen |
Clahe |
Raw Image infos
Clip black: 1020 Clip white: | 1706
spatial Std dev: | 102.741 Mean: | 1319.23

[+ Histogram
Bar chart color: . I Mean fine color: . I Std dev color: . [ 1 Mean [ Standard dev

3000
5000
]

2000

0 S S T O S O O W (e e e

o Y

Value 0-255

x(-2.83850 | v [307.602 |

Fig. 25 : Image processing plugin




Filters | Common | Tone Mapping

Filters (can slow down the application)

Denaising

L] Enable

H coeff: | 3.00 EI: Template Window Size: | 7 | Search Window Size: | 21 EI

Sharpen

Clahe

Fig. 26 : Filters tab

The software offers some basic image processing functions, in the “Filters” tab you will have access
to a "Denoising” filter, a “Sharpen” filter and “Clahe” filter with all their parameters.

Filters | Common | Tone Mapping‘

(] Manual Clipping
DisplayedPixelValue = alpha * pixelValue + beta
Alpha: [ 0.00000 —] Beta: {0.00000 —

Hb Images for accumulation: | 10 — [ ] Enable

Clipping parameters
Limit type Clip depth Limit value

Mean v| | 1 | 2000 =

Fig. 27 : Common tab

The “Common” tab has the software bad pixels correction (see section 5.5.3.3). A manual clipping
with a function “Alpha” * pixel value + “Beta”, and an image accumulation.




Filters | Common | Tone Happing‘

Drago vl

Gamma 1.23

Saturation 0.99

Bias 0.97

Multiplicator | 2 EI

Fig. 28 : Tone mapping tab

The "Tone Mapping" tab change the tone mapping used to transform the 16b image to the 8b
image, four tone mappings are available, “Normal’, “Drago”, “Reinhard” and “Mantiuk”. All these tone
mappings come with their parameters that you can change when you want to have the best result.

profil_2 "I [ Delete] [prnﬁl ] [Save]
Fig. 29 : Image processing profiles

All parameters can be saved in different profiles, just enter a name in the line edit next to “Save”

button, click on “Save" and the profile will be added to the list. To delete a profile, choose it in the list
and click on “Delete”.




6.SHORTCUTS

6.1.Main window

Mouse left click and move on image -> blue rectangle for clipping.

Mouse right click and move on image -> red rectangle for analysis (disable it by right click in
another place of the image).

‘Shift" + mouse left click and move on image -> green line for section (disable it by “Shift" +
mouse left click in another place of the image).

“Ctrl" + mouse wheel on image -> zoom in/out.

‘Ctrl” + mouse left click and move -> move the image.

Mouse wheel click and move -> rotate image.

“Ctrl +s" start/stop acquisition.

‘F5" refresh GUI by reading all parameters from camera.

*Alt" + mouse left click -> draw a region of interest

"Alt" + mouse right click -> draw a rectangle which remove all region of interest inside it.

6.2.Bad pixel editor

"Alt" + left mouse click on pixel not in the map -> add pixel to map.

*Alt" + left mouse click and move -> add pixels to map.

*Alt" + left mouse click on pixel already in the map -> remove pixel from map.

‘Shift" + left mouse click and move -> yellow rectangle, all pixels in the rectangle and in the
map will be removed from the map.
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